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1 Welcome

We congratulate you on your purchase of our app Reconstruction. Thanks for deciding to purchase one
of our products.

With the Reconstruction it is possible to regain lost or non up-to-date ETS project data by reading out
the plant.
The Reconstruction discovers all the devices connected to the Bus and collects all the data from the
relevant storage.

The available functions in Reconstruction may be restricted by the used ETS license. In addition, you will
find further details in the online help of the ETS.

Knowledge of Windows and ETS is necessary for an understanding of the contents described.

Reconstruction Features

How to ...

· Reconstruct an EIB/KNX installation (Reverse Engineering)

· Compare an EIB/KNX installation with an ETS project

Windows

· Reconstruction Window

Symbol bar

· Buttons: Scan Topology, Scan Devices, Read Products, Read Devices, Reconstruct, Compare,
File (Load State, Save Current State, Load Keyring), Help

Additional Information

· Contact (Orders, Support)

1.1 Conventions

The following conventions were used for this manual:

· Bold print either highlights important terms, denotes a menu command or pressing a button.

· Italic print indicates a variable text, e.g. Project file indicates that the name of your project file
must be inserted here. 

· > and >>  The symbol > in a brief description denotes an operational sequence. In front of the
sequence symbol > there may be a site specification e.g. main menu or context menu. 
Example: Main Menu > Edit > Properties properties-page > General means that in the main menu
you should first select the Edit menu command and in it the Properties command, then proceed in
the dialog which has opened up to the General properties page. 
If a double mouse click is necessary the sequence symbol will be doubled >>. The terms left/right
mouse button refer to the standard Windows setting.

Screen images and operating sequences refer to a Windows XP operating system. If you use another
operating system, your display or operation may deviate from the illustrations in this manual.
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1.2 Features

Reconstruction helps you to reconstruct lost or outdated ETS project data by reading the programmed
devices.
Reconstruction discovers all devices present on the bus and reads the relevant memory ranges. Using
the product data for the devices, it then tries to create an ETS project that would lead to exactly the read
device data.

Compared to the Reconstruction for the ETS3, the reconstruction App for ETS5 has been completely
redesigned and offers, particularly regarding performance, significantly improved mechanisms for
reconstruction. InIn the latest version even more intelligent, fast and fault-tolerant capabilities for reading
and reconstructing projects from existing plants have been realized.

Areas of application

· Recovery of lost ETS project data

· Update of outdated ETS project data

· Extension of unknown installations

· Creation of data for visualization (e.g. for Elvis)

This data can be reconstructed.

This data is not programmed into the units and therefore cannot be

reconstructed.

Restrictions

In some cases, reconstruction might fail or finish incomplete:

· Devices that are not supported by the ETS, cannot be reconstructed. 

· Devices locked with an unknown BCU password may not be readable. This depends on the
specific product. In most cases, readout is possible without any problems, but the device cannot
be reprogrammed without knowing the BCU password (there may be exceptions here as well).

· Devices that are programmed with an ETS Plug-in, can only be read and reconstructed if the
device manufacturer supports this (by a corresponding Reconstruction Plug-in).

· Some Application Programs contain parameters that are not programmed into the device (e.g.
comments on documentation). These functionally ineffectual parameters can therefore not be
recovered.

· It is possible that Application Programs exist with complex parameter interdependencies that
cannot be resolved by Reconstruction (the message "Reconstruction incomplete" will appear). In
this case, please contact our Support. We will then try to find a solution.

1.3 System requirements

· You can use this software only together with the EIB/KNX Engineering Tool Software ETS 5.7.2 or
higher.
For ETS2 and ETS3, older Reconstruction versions are available directly from IT GmbH.

· All operating systems on which ETS 5 and ETS 6 can be installed are supported.

· The software uses less than 1 MByte space on the hard disk.

http://www.it-gmbh.de/deutsch/products/
https://www.it-gmbh.de/en/products.html
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2 Procedures

2.1 Launching Reconstruction

To work with the Reconstruction, you first need an ETS project.
If you do not have any project data for the existing plant, please create a new project in the ETS and
open it.
If an ETS project already exists, but is e.g. incomplete or outdated, please open this project

Reconstruction integrates itself as menu command in Apps -> IT GmbH. If you use Reconstruction
regularly, you will find it useful to add Reconstruction as a button in the ETS toolbar.

Click on the menu item or toolbar button to open Reconstruction window.

2.2 Reconstruction file

The current state of the Reconstruction (scanned areas, lines and devices, read device data) can be

saved in a file at any time and loaded again later. To do this, use the File -> Save Current State button.

The Reconstruction  files have the file extension ".xml". It is also possible to load reconstruction files
with extension ".prj" created by IT reconstruction for ETS3.

After certain steps such as loading, scanning, reading devices, etc., the current state is also
automatically stored in the local Temp directory in the IT GmbH\Reconstruction subfolder. The file name
consists of the ETS-internal project ID and the name of the project. You can navigate to your local Temp
folder by entering %temp% in the Windows search box. Here you will find the latest version of your
reconstruction file.

2.3 Reconstruct an ETS project

Using Reconstruction, you can create an ETS project from an existing installation. This is useful if no
ETS project is available at all. Please add an new project in ETS, open this new project and activate the
reconstruction panel.

It is also possible to update an existing ETS project with data from the installation. This is useful if the

ETS project exists but is outdated (e.g. an older backup copy). Please open this project and activate the

reconstruction panel.

The following pages will guide you through the process of reconstructing a project. You can save the
current status to a reconstruction file at any time during the process and load it again later.

When done, you can post-process the created project in ETS:

· Enter meaningful names for lines, devices and group addresses.

· Create a building structure and assign the devices to rooms.

· Reconstruction tries to assign a suitable product (hardware) to each found Application Program
(software). For one Application Program there may exist more than one product in the ETS. You
may correct the assignment done by Reconstruction in Products Page or manually in ETS. Note
that a product assignment not reflecting the real product has no adverse effect on functionality.
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2.3.1 1. Define Topology

Initially, the topology (area/line structure) must be created in the Reconstruction project. Reconstruction
offers several ways to define the topology, which can also be combined.

Scan topology from installation

How it works

Reconstruction scans the installation for line and backbone couplers and derives the possible areas and
lines from this information. For this operation, bus access is required.

Prerequisites

As for all bus functions, it is important that the individual address of the gateway in ETS is set correctly
(suitable to the line connected, no collision with other addresses).

· Option 1: Connect a USB module to a flush-mounted BCU already existing in the installation. Then
you automatically have a correct gateway address.

· Option 2: If you connect your own gateway to the installation, first determine the line address (e.g.
by pressing the programming button on any other device on the same line and reading the address
using ETS > Diagnostics > Individual Addresses > Programming Mode -> result: area.line.device).
Then set the gateway address to e.g. area.line.254, scan the line area.line in ETS > Diagnostics >
Individual Addresses > Line Scan and finally set the gateway address to a free address.

Procedure

· Click on the "Scan Topology" button.

· Scanning the topology may take several minutes; you can abort the operation at any time.

Result

· When scanning Reconstruction searches for area and line couplers for all possible line addresses
(0.0 to 15.15). As a result you will get a list of areas and lines for which an area or line coupler
was found (so far without devices). Names of areas and lines are not stored in the installation,
therefore they cannot be read out or recovered.
You can save the result by "File -> Save current State".

Enter topology manually

It is possible to create areas and lines manually in a reconstruction project (e.g if the topology is known).
No bus access is required for this:

· Select the Manually add Area from the context menu (right mouse click in the left area of the
reconstruction window). A new area is added; you can edit the automatically assigned area
address immediately in areas property dialog (visible on the right edge).

· Select an area in tree view in the left window and add a new line by the "Manually add Line"
command from the context menu. You can edit the automatically assigned line address
immediately in line's property dialog.

· If you created an area or line by mistake, you can remove it using the "Delete Line" command from
the context menu.
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Scan single device

2.3.1.1 Scan Single Device

If you want to read out and reconstruct just a single device with known address, of course you do not
need to scan the entire topology of the installation.

· Select "Scan Single Device" command from the context menu (right mouse click in the left side of the
reconstruction window), specify the device address in the dialog box and confirm with OK. An area
with a line and a device with the specified address will be inserted - if not already present - and the
scanning process starts automatically.

· After the scan the device should be correctly identified with Application Program ID. You can now
continue working with "Read products".

2.3.2 2. Scan Devices

After the topology has been defined, Reconstruction can search for existing devices on some or all lines.
For this function, bus access is required.

How it works

Reconstruction  scans through all possible device addresses 1-255 in the selected lines. If a device
is found at an address, the mask version and the Application Program ID are read to identify the device.

Prerequisite

As with all bus functions, it is important that the individual address of the gateway in ETS is set correctly
(matching the line connected, no collision with other addresses).

Procedure

· If you are only looking for devices in certain areas or lines, please switch to the option Selected in

the left window below and mark the areas or lines to be scanned with . This check mark is only
taken into account if the Selected option is active. If the option All is active, the marking is
ignored. All areas and lines are scanned for devices.

· Select "Scan devices" button from the reconstruction tool bar.

· Scanning the devices may take several minutes; you can abort the operation at any time.

Result

· As result you will get a list of all devices found in the installation including information about
individual address of each device, mask version and Application Program ID (still without group
addresses and parameters). 

· Device status should be No product data or not read. 
In case of Not identified please use Scan single device or scan the complete line again.
You can save the result by "Save current State".

Hint: The scanning process creates a considerable bus load on the affected lines. This is increased
by the fact that this function by its nature also tries to contact non-existing addresses which leads to
corresponding repetitions.
If you experience problems (e.g. with line/backbone couplers), you can limit the bus load by scanning
the installation line by line or at least area by area, and connect the PC directly to the line (or main line).
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No devices found?

Scan single device

2.3.3 3. Read Products

After scanning the devices it is known which Application Programs are used in the installation. You can
find a corresponding list on the Product Page in the reconstruction window.

If product data is already available for all devices and all product data are assigned the you can skip this
step.

Since ETS5, only the product data that has already been used or referenced in the current project is
available.

With the command "Read products" Reconstruction searches the ETS manufacturer catalogues with the

imported product data. In addition, all other open projects and, depending on the configuration setting,

also the online catalogue are searched for the required product data. These are then referenced in the

current project. Depending on the size of the catalogue, this operation may take some time.

The Read Products button in the tool bar offers two options. When you click the left (main) part of the
button performs the product search for missing Application Program IDs in project. This also applies to
the Read products button in the yellow note window, which is only displayed before the first execution of
"Read product".
Us the small arrow in the right-hand part of the button, to reach a sub menu with these two entries:
· Read all products: all product data found in the reconstruction file (if option All is used) or in marked

devices (if option Selected is used) are read again regardless of whether these were already found or
not.

· Read missing products: functions as above: reads the product data only for those Application Program
IDs for which the product data were not found yet (options All / Selected are taken into account).

Of course, the second option will be faster. However, if you have imported new catalogue entries (e.g.
with additional order numbers) for devices with already existing product data, please use the option
"Read all products".

If you only want to read product data for individual devices, please switch from All to Selected in the left-
hand window below and mark the relevant devices. This marking is only taken into account if the Marked
option is active. If All is selected, the marking is ignored (hidden) and product data for all devices (in
reconstruction file) are searched.

When "Read products" has finished you will then be redirected on Product Page. Please check the
product list for entries with status "Not found, please import product data". The associated devices with
this product data can not be read out or reconstructed,  if you do not import a suitable product database
now or open another project which contains product data.
It is necessary to perform "Read products" once more to add the new product data into the current
project.

On Report Page or Product Page, you can export a list of Application Program IDs with missing product
data.

Where do I find suitable product data?

For devices with hint "Please select product" please double-click to open the list of available products
and select the desired product. If the list is empty, the product data must be imported.
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Why does Reconstruction need product data for reading devices?

2.3.4 4. Read Devices

In this step, Reconstruction reads the relevant data from all found or selected devices. To find this data in
the unit memory, the associated product data is required. Without bus access and product data, no
readout is possible! 

Procedure

· If you only want to read out certain devices, please switch to the option Selected in the left window

below and mark the devices to be read with . This check mark is only taken into account if the
Selected option is active. If the option All is active the marking is ignored (hidden), and all devices
are read out.

· Click on the "Read Devices" button from the Reconstruction tool bar.

· Reading the devices may take a very long time; you can abort the operation at any time.

· During the readout, warnings, error messages and other information are logged and displayed on
the output page.

Result

· As a result, you receive the associated group addresses (only the address, no names or texts),
flags and priority of the communication objects as well as the (undecoded) content of the memory
area for the parameters (according to product data) for each read device from the list.

· Device Status is "Read".
You can save the result by "Save current State".

Why can't devices be read out?

2.3.5 5. Update project

This is the last step in recovering an ETS project. For this operation, to bus access is not required.

Choose this method if the ETS project data do not exist or are outdated. 
You may also use this method to reconstruct a project in several iterations by reading only a part of the
installation and then incrementally update it for more parts step by step.

Note that update overwrites the original data. Consider making a backup copy first.

During the project update names, comments and other data are preserved. All new discovered areas,
lines, devices and group addresses are added, and parameters and group address assignments are
updated.
Areas, lines, devices and group addresses exist in the ETS project, but not in the read-out data, are not
deleted.

Procedure

To update the project, click on the "Reconstruct" button in the upper part of the reconstruction window.

Output of reconstruction
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During the scanning, reading and reconstruction steps, all the warnings, error messages and other
information are logged and listed on the Output Page.

Result

· In the current ETS project devices and group addresses are added or updated. 
Note: names or descriptions are not stored in the device's memory, so they cannot be recovered.

· The Device Status should be "Reconstruction OK". If status is "Reconstruction incomplete", see
"Incomplete Reconstruction"
You may save the result by "Save current State".

2.4 Compare

You can use Reconstruction to compare an EIB/KNX installation with an existing ETS project. This is
useful to

· verify the conformity of project planning and installation (e.g. for acceptance)

· analyze problems which are otherwise difficult to find

Execute steps 1 to 4 as described for reconstructing a project or load a previous reconstruction file.

Click on the "Compare" button from reconstruction tool bar. Access to the bus is not required during
compare.

Compare will always work against the current ETS project. The comparison can take a very long time for
large projects and complex devices; you can abort the operation at any time.
Reconstruction tries to find a matching parameter configuration based on the read data that has the
same memory image as read. If such a configuration is found, the parameters can be compared
individually, the result can be found in the reconstruction info in the Device Detail dialog.
If no matching parameter configuration was found, but the current parameter configuration in the ETS
device provides a different memory image than the one read out, the parameter setting is surely different
in device and ETS project, but no detailed result for parameters can be determined.

If you only want to compare certain devices, please switch from All to Marked in the left-hand window

below and mark the relevant devices with . This marking is only taken into account if the Marked
option is active. With All, the marking is ignored (hidden) and all devices will be compared.

Devices which are present in the ETS project but not in the read-out data (reconstruction file) are listed in
the log output on "Output" page and can be conveniently found in the ETS project via the navigate to
project element button (small black triangle). 
This comparison is always carried out- regardless of whether only some or all devices from the
reconstruction project were selected for comparison.
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3 Reference

3.1 User Interface

3.1.1 Reconstruction Window

To be able to work with the reconstruction, you first need an ETS project. 
If you do not have any project data, please create a new project in the ETS via New project and open it.
If an ETS project already exists, but is e.g. incomplete or outdated, please open this project.

The reconstruction window contains a Toolbar with the operation steps necessary for the reconstruction
and displays information on the following pages:

· Project: Displays the topology with devices and associated group addresses.
With the options All and Selected in the left window below you can switch between two different
modes: in mode Selected you can mark individual areas, lines or devices via a check box. The
reconstruction operations then only refer to these marked elements. In the mode All, all contained
elements are always processed.
More on the objects can be found for selected entries in the Properties dialog in the right-hand
side area of the ETS.

· Products: Overview of product data for the read Application Program IDs

· Reports: Outputs prepared as a report for missing product data and for devices for which problems
occurred during readout or reconstruction

· Output: Log file for reading and reconstruction or comparison operation

Below the Toolbar, settings can be changed in the expandable configuration area. E.g. the maximum
number of iteration steps in the reconstruction (=> incomplete reconstruction) or various options for
finding the product data can be configured: e.g. the file path of the product finder catalogue file or whether
the online catalogue should also be searched when reading products.

3.1.2 Tool Bar

The Tool Bar offers the tools to work with the Reconstruction.

 Scan Topology Scans the topology structure of the installation and adds the found
areas and lines on the Project Page.

 Scan Devices Scans for all devices in the lines listed on the Project Page, reads out
their physical addresses, mask versions and Application Program IDs
and displays the devices on the Project Page.

 Read Products 
Searches in ETS manufacturer catalog items, all opened projects and -
depending on the settings - also in the online catalog for product data
and adds them into the current project,
switches to the Product Page and displays a list of all used products
and Application Program ID with information if the product data are
already available in ETS and for which product data still has to be
imported.
Using the small arrow on the right part of the split button, two sub-menu
entries are available, which only differ in the extent of the search area:
Read all products performs the same operation as Read products: it
looks for all product data in the manufacturer's catalog items which
matches the Application Program ID - regardless whether the product
data are already known or not. This can be useful after importing
additional catalog entries with different order numbers to an existing
Application Program.
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Read missing products, on the other hand, only takes into account the
application identifiers without product data.

 Read Devices Reads the relevant memory data from all devices - as far as possible.

 Reconstruct
Inserts group addresses, areas, lines and devices into the ETS project

on the basis of the read-out data, if not already present. Then, for each

device, a parameter configuration is calculated that matches the

respective read-out memory area. After that the parameter values in the

ETS are altered accordingly and the flags of the communication objects

are set and links to the group addresses are created.

 Compare Compares the read data with the current ETS project (same mechanism
as for reconstruct but without update, only logging the differences).

 File This menu contains file operations:

Load State Opens and loads an existing Reconstruction state from a xml or prj file.

Save current State Saves the current state of the Reconstruction into a xml file.

Load Keyring Loads an ETS keyring export, see KNX Data Security.

 Help Opens this help file.

3.1.3 Project Page

This tab page displays all areas, lines and devices found in the installation.

Areas and Lines (left pane)

On the left, the bus topology is displayed. For area and line addresses, the number of contained devices
is displayed in [] brackets.
The topology definition is always the first step when using Reconstruction. Reconstruction may scan the
topology from the installation or you may create/edit the topology manually.

The buttons All and Selected indicate which elements are effected by an action. If All clicked, then all
elements in the topology will be affected by any action, in case Selected is clicked the action will only
refer to the marked areas, lines and devices in the topology. Note that check mark is only taken into
account if the Selected option is active. If All is selected, the selection is ignored - all areas, lines and
devices are processed.

Devices (right pane)

All participants found on the line selected on the left are listed on the right side. The individual columns
are:

Address Individual address (device address)

Status Status for device data

Mask Version Mask version of the device
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Manufacturer Manufacturer of the Application Program. If a number is displayed instead of
the name, the manufacturer is not (yet) known in the current ETS project. In
the ETS, the manufacturer's name is updated by "Read products". A list of
manufacturer codes is available from our Web page.
If the field is empty, the manufacturer code could not be read from the device
(which is quite usual for Couplers).

Application Program Application Program ID of the device; if the corresponding product data is
available in the ETS, the name of the Application Program is displayed.

Product Order ID and Name of the Product (catalog entry) for the device.
For some application programs more than one product may be available. In
this case the assignment can be made by opening the drop down menue and
selecting an entry (=> Change product). 
Another option is to drag a product from the catalog or a device from a project
on the row.
This change only affects the current device.

GroupAddresses assigned Group Addresses 

3.1.4 Products Page

On this tab page the Applicationprograms - found in the installation - are displayed.

The meaning of the column entries are:

Manufacturer Manufacturer of the application program. If a number is displayed instead
of the name, the manufacturer is eventually not (yet) known in the current
ETS project. The manufacturer's name is updated by "Read products".

Exceptions are line couplers whose manufacturer code has not been

stored in the unit.

If a number > 0 is still displayed as the manufacturer, you will find a list of

manufacturer codes on our homepage. 

Application Program Application Program ID of the device and name of the application if found in
the ETS database / current ETS project

Product Order ID and name of the product
For some application programs more than one product assignment is
possible. In this case the assignment can be made by opening the drop
down menue and selecting an entry (see also: Change product).
Another option is to drag a product from the catalog or a device from a
project onto the row.
This change only affects the current device.

Devices Number of devices in current project, using the same product.

If you select an entry on the "Products" page, this information - depending on the configuration - is

displayed in the ETS sidebar.

If there are lines without an application program or without a product, you should first execute the "Read
products" command before continuing (if you have not already done so).

https://it-gmbh.de/en/products/knx/ets-apps/reconstruction/
https://it-gmbh.de/en/products/knx/ets-apps/reconstruction/
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If product data is still missing after this, please import the current product databases of the
manufacturers concerned (=> "Where do I find suitable product data") or open another project and then
execute the command "Read products" again.

Reconstruction can only be complete if an Application program is entered and at least one product is
assigned to each Application Program.

With the button "Export ApplIds without product data" right below you can create a text file with all
Application Program IDs, which have currently no corresponding product in ETS database/current ETS
project and for which an import of product data is required.

3.1.5 Reports Page

On this tab page the reports of the current state of reconstruction will be shown.

The Output is shown in a split window. In the left area of the window the available reports are listed and
selectable. The content of a chosen report will be displayed within the right area of the report page. Here
you have the possibility to print the report, to save a marked part of the report or to zoom into or out of
the report by clicking on the icons shown above.

The box on the lower part of the report page gives the possibility to search for text within the report. Enter
the text you want to search for. If you click on the right arrow or press enter, the report is searched
downwards. To search upwards click on the left arrow. 
In addition different search options are supported. By clicking on the black down arrow the search can be
restricted.

3.1.5.1 Missing Products

In this report all missing products are listed with their manufacturer number and their Application
Program ID if the device is installed in the topology but does not exist in the ETS project.

3.1.5.2 Problem Device

When errors appear while reading, reconstructing or comparing a device, the device will be listed in this
report. The device address and the problem will be shown in the report problem device.

3.1.5.3 Report All Devices

List of all device data in the Reconstruction panel.

3.1.6 Output Page

This tab lists all warnings, information and error messages that occurred during the scanning, reading,
reconstruct, or compare operations.
In contrast to the Properties dialog which displays only the information about the currently selected
device, on output page all devices in the overview will appear.

Using the button "save log file" right below you can save the log output to a text file.

3.1.7 Details

This dialog displays all data regarding the marked row. Depending on what you have marked - an area, a
line or a device on ProjectPage or a product on ProductPage - the dialog will appear with different
information. 
If several entries have been selected, only the information that is the same for all selected entries is
displayed.
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The following dialogues are available:

for the ProjectPage: 
· Area Details
· Line Details
· Device Details

for the ProductPage: 
· Product Details

3.1.7.1 Area Details

The window shows detailed information for the area:

Address Address of the area. If no device is listed for the area it is possible
to change the address

3.1.7.2 Line Details

You can change the following Line Details in case no device exists in the line

Address Address of the current line
Medium Type Medium type of the current line

3.1.7.3 Device Details

The Device Details list a higher amount of parameters than area or line details.Therefore it is divided into
four parts:

· General
· Communication Part Info
· Parameter Info and
· Reconstruction Info

Common

The general information is listed to get a more comfortable overview.

Area.Line
Address

Addresses of area and line
Address of the device, can be modified if the device has not yet been
identified

State State of Reconstruction for the current device
Mask Version Mask version of the device
Manufacturer Manufacturer of the device
Appl Key Application Program ID of the device
Appl Program Name of Application Program for the current device
Program Style Information about Product data (internal)
Product Product description (Catalog entry) for the device
Order ID Order number for the device (unique per manufacturer)
Group Addresses Group addresses connected to this device
Additional
Addresses

Additional individual addresses, if found (hidden for devices without additional
addresses)

Plugin CLSID ClassID of the plug-in, if used (hidden for devices without plug-in)

Communication Part Info

This table lists all group objects of the device. Flags, priority, length in bits and the corresponding group
addresses are displayed for each object.
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Parameter Info

The raw image segment with parameters for the device are shown. To see the complete list use the Tool
Tip.

Reconstruction Info

Before the reconstruction had been started, the information of the device is shown here, if Reconstruction
info is not invisible.

Copy to clipboard

The texts in this window can be copied to the clipboard via the context menu.
In addition, the command "Copy to clipboard" copies the entire content of the property page to the
clipboard.

3.1.7.4 Product Details

This information is available (only read access).

Manufacturer Manufacturer's name
Appl Key Applicationprogram ID  or name of application program
Product Product description (Catalog entry) 
Devices Addresses of all devices assigned to the product entry
Product data available in
these file(s)

Projects: If you select "Search in local projects" in the configuration,
the required product data is searched for in the local ETS project
memory and a list of project names is displayed. To include the
product data into the current project, just open any one of the projects
in ETS and perform 'Read Products' again.

Product finder Catalog file: If you select ‘Use product finder catalog
file’ in the configuration, a list of all product or project files will be
displayed here as result of a query of looking for product data with
current Application Program ID in the Product finder catalog file. 

Note: In case of an error a warning/error sign will be displayed, by
hovering the mouse over the sign, error message will be displayed.

Note: these product data files cannot be imported automatically by 
Reconstruction, you must do this manually by following methods:
o In ETS5: Using the context menu, you can copy the file path and

insert it into the ETS import dialog.
o In ETS6: By clicking on any of the links, product data import will

start.

Online: If you select Use Online Service (with valid access key), a list
of required product data links will be shown.

Note: A green OK status symbol will be displayed if server can
reachable. However,in case of an error a yellow warning or red error
sign will be displayed, by hovering the mouse over the sign, error
message will be displayed.

Note: these product data files cannot be imported automatically by 
Reconstruction, you must do this manually by following methods:
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o In ETS5: By clicking on any of the links to download the product

data file, then manually import it by using ETS catalog import
dialog.

o In ETS6: By clicking on any of the links, the product data import

will start.

Note: After importing the product data, perform the "Read Products"
step again, to update the Reconstruction project. 

3.1.8 Configuration Dialog

ETS5: you will find the list of installed apps via button "Apps" at the bottom right on ETS5 start page.
Please mark the app Reconstruction in the list of installed apps, and then open the configuration dialog
via the icon (grey gear) in tool bar.

ETS6: you will find the list of installed apps via clicking the button "Settings" at the top right on ETS6
start page.Then click the  button "ETS Apps" in the Settings window on the left. Please mark the app
Reconstruction in the list of installed apps, and then open the configuration dialog via button
"Preferences" with the icon (grey gear) on the right of the Settings window.

The options set here are used for each newly created project but can be changed project-specifically.
The project-specific options are stored in the ETS import file (knxproj), so they are available after ETS
import.

The project-specific options will be found in the App Window at the top of the toolbar at options.

You may change the following options:

Product data handling:

· Use Online catalog: If checked "Read products" will also include products from KNX Online Catalog.
This also applies to couplers if the manufacturer is known.

· Search in local projects: If checked, the projects available in the local ETS project store will be
searched.

· Use online service: IT GmbH provides a (chargeable) Online-Service that gives you the access to
thousands of current and older product data.

   Note: When selecting this option, following status symbols will be displayed, and hovering the mouse
over the symbol will display status message.

o Yellow warning sign: If key is not configured, or service is temporary down.

o Red error sign: If not a valid key, or any other error.

o Green OK sign: If Key is valid, and server can be reachable. 

· Use Productfinder catalog file: here you can store the catalogue file from the ProductFinder containing
the information, in which file (on your computer) which Application Program is contained.

Note: When selecting this option, following status signs will be displayed.

o Yellow warning sign: If catalog file is not configured

o Red error sign: If not a valid catalog file, missing catalog file,or any other error.

Go to the Products Page and select a product entry. You will get a complete list of all product and
project files that contain product data for the current application program ID (selected product entry).
The selection is displayed in the ETS sidebar.  ETS5, using the context menu, you can copy the file
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path and insert it into the ETS import catalog dialog. However, in ETS6 you can directly import it by
clicking on the link.

· Default coupler manufacturer: If this option is selected together with a manufacturer from the list,
coupler products of this manufacturer will be considered preferentially when reading products if the
reconstruction could not determine the coupler product.

Identifying / reading

· Use long frames if supported: Try to use long frames if possible. This will considerably speed up
reading devices if supported by the device, the interface and any couplers in between. In case of read-
out problems, re-try with this option unchecked.

· Identify unloaded devices: As unloaded devices usually do not contain any meaningful data in the
device memory, they are skipped during identification. With this option, the Reconstruction also reads
the identifiers from these devices so that they can be read and reconstructed in exceptional cases.

· Show warning for devices identified or read out with a previous version of Reconstruction.

Reconstruction

· Overwrite existing device: You can choose between the options "Always", "Never" and "Prompt". 
For "Always" devices already existing in ETS project are overwritten with the reconstructed parameters
and group address data, for "Never" they will be skipped, and for "Prompt" you will be asked  for each
device before reconstruction starts with the possibility to confirm, skip, change to "Always" or cancel
the procedure.

· Maximum of iterations for undetermined parameter values: some products contain many virtual
parameters, which the Reconstruction cannot determine in one step because of too many possible
combinations. The maximum number of iteration steps is set to 100 so that the Reconstruction does
not take an extremely long time to calculate and possibly does not find a suitable solution. You can
use this option to change this number.

· Use algorithm for ETS4 applications also for older products (PreETS4 style): activation of this option is
recommended, as most older devices can also be quickly reconstructed using the reconstruction
mechanism specially developed for ETS4-native Application Programs. 
Only for a few multifunctional devices with many virtual parameters and communication objects the
method for older devices may be more useful. In this case please deactivate the option and execute
the reconstruction for these devices individually. Usually the reconstruction must be performed several
times until all necessary parameters are determined.

3.2 Special Considerations

3.2.1 KNX Data Security

Reconstructing devices protected by KNX data security is possible only if the tool key of the device is
known.
This does not apply to devices which do support KNX data security, but do not have it activated.

When scanning or reading devices, Reconstruction tries to use the tool key from the following sources:
· the configured tool key of the corresponding device in the project (identified by its individual address)
· ETS also remembers the tool key used for the last download (which might differ from the configured

tool key if the device security was changed after the last download)
· the Reconstruction data (i.e. the XML file which can be saved or loaded) may also contain a tool key.

This can be seen in the side bar when the device is selected in Reconstruction. See below on how to
enter this data.

If no tool key is available, the status text of the device will display "Secure device cannot be read without
key".
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If a key is available, but has not yet been tried, this changes to "Secure device with possible key, please
re-read".

Load keyring backup

It is possible to export a keyring backup file from ETS. This contains, among other things, the required
device keys.
Use the File > Load Keyring command from the toolbar to select the file.
As the keys in the file are encrypted, you must enter the correct password - as specified when exporting
from ETS. Note that there is no way for Reconstruction to verify that the password is correct. A wrong
password is accepted, but the decrypted keys will be useless.

Reconstruction Result

If the correct key is available, secured devices can be reconstructed the same way as plain devices. For
secured devices the following applies:
· the security status of the device in the created project corresponds to the stats of the read device.
· the key is stored in the ETS project as "last known key" so that ETS canto communicate with the

device
· ETS will however create a new tool key for the device which will be written to the device on the next

download

For secured IP devices the following applies in addition:
· ETS will create new passwords and authentication codes; these will be written to the device on next

download.
· for a secured IP backbone, ETS will create a new key. If you load one IP device or KNX/IP Router, you

have to download also all others, so that the IP backbone communication continues to work (then with
the new key).

For secured group addresses, the following applies:
· ETS will create new keys. If you load one device linked to a secure group address, you have to

download also all others linked to the group address, so that the group communication continues to
work (then with the new key).

3.2.2 Couplers

The product data identification for couplers (line couplers, media couplers, KNX/IP Routers) is
unfortunately not standardized. Reconstruction uses some heuristic rules but these will not work in all
cases.

So please check after scanning Topology or Devices and best before reading devices that the couplers
have been correctly recognized.

If the product has not been recognized at all (displays the Mask version in the column "Application
program") or incorrectly, drag the correct product from the catalog or (as device) from an ETS project
window onto the row in the Project Page (affects only this device) or the Products Page (affects all
devices of the same kind).
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4 Questions and Answers

4.1 Result of reconstruction

As a result Reconstruction provides an updated ETS project with devices and group addresses used in
the current installation (see: Procedures > Reconstruct an ETS project). Parameter settings of devices
and group object associations are set corresponding to the installation. 

This applies under the condition that all devices in the installation can be read out completely, that all
product data are available in the current ETS project and can be used and that a suitable parameter
combination could be calculated based on the product data and the data in the parameter image of the
devices. For not fully reconstructed devices, see Reconstruction Incomplete.

The building structure as well as names and descriptions etc. of areas, lines, devices and group
addresses are not stored in the installation, so they cannot be recovered (Which data can't be
recovered?). When Reconstruction inserts a new area, line, main or middle group or group address into
the current ETS project, these devices will get the name "Added by Reconstruction". It is recommended
to replace this name by appropriate labels in the context of the post processing of the project.

If you choose the command "Compare" instead of "Reconstruct", the status of the devices in the
reconstruction window informs you whether differences on the project were found or not. Reconstruction
will compare only based on the data in the current installation. That means that devices that are present
in the project but not in the plant are disregarded.

4.2 Does reconstruction work also for old projects?

Reconstruction also works for old projects which were created with a previous ETS version (since
ETS1). 

The only important criterion is that the product data which had been used for programming are now
present in the current ETS version - exactly with the same Application programe ID as used for
programming. 
Product data should exist at least in ETS2 format, so that they can be imported into the current ETS.
The exact format does not matter (vdx... vd5 or knxprod), even a project file is sufficient  (prx... pr5 or
knxproj).

However, a few old products are no longer supported in ETS4/ETS5/ETS6 - in the ETS product catalog or
device overview it will be marked by "Re-import required".These devices cannot be inserted into an ETS
project with ETS4/5/6, so they cannot be reconstructed.

4.3 How much time does reconstruction take?

There is no universal answer for this question. Time needed for reading and reconstructing depends on
the size of the installation, the kinds of integrated devices, bus traffic, gateway etc..

A reconstruction includes the scanning of the topology, the scanning and reading of the individual
devices (each with bus access) as well as the actual reconstruction (offline), where devices and group
addresses are inserted into the current ETS project from the read-out data.

If topology of installation is already known, scan of topology can be skipped by editing the areas and
lines manually.
Scanning and reading will be faster if the local gateway is mounted in each line (note: adapt address of
gateway to current line). This way and so the devices in the installation will be read line by line.
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The real reconstruction process (adding device into the ETS project, parameter settings, connections
with group addresses) can be done in less than a minute, but can also take one or more hours. This
depends on product data (parameter structure). 
Normally, older devices (e.g. with BCU1) can be read and reconstructed faster than devices with other
masks.

4.4 Why does scan topology only find area 0 and area 15?

Possible causes:

The individual address of the data interface as configures in ETS has not been set or does not
match the line where the interface is connected (e.g. local address  15.15.255 on line 1.1).  

The line address can be determined e.g. by putting a device on the same line into programming
mode and read its address with the ETS function Diagnostics/Individual Addresses.

What to do: configure a correct address for the data interface (ETS4 in Settings -
Communication, in ETS5 in Bus - Connections - Interfaces). In ETS6 interfaces are related with
the project, so can be found in the project on the top right dropdown menu and then the grey-
gear icon.

4.5 Why are no/not devices found?

Possible causes:

The individual address of the data interface as configured in ETS does not match the line where
the interface is connected (e.g. local address 1.1.250 on line 1.7). 

The line address can be determined e.g. by putting a device on the same line into programming
mode and read its address with the ETS function Diagnostics/Individual Addresses.

What to do: configure a correct address for the data interface.

A device in the installation has the same individual address as the data interface. 

You can check this in ETS5 - Bus - Connections - Interfaces and in ETS6-In Project-top right
dropdown menu grey gear icon.

What to do: configure a correct address for the data interface.

A line coupler is configured incorrectly.

What to do: Scan line by line.

There are special devices for the purpose of preventing all programming and readout operations
on the bus.
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Try to read a device with the ETS function Device Info (you can determine the address as
described above via programming mode). If that does not work, such a device might be the
cause.

What to do: you have to locate (that's the difficult part) and remove the interfering device.

The installation contains only one physical line (no line couplers) but the devices have
addresses with different line parts (e.g.: 1.1.3, 1.2.5, 1.4.200). 

Such an installation does not conform to the KNX/EIB topology; Reconstruction therefore
cannot determine the topology.

What to do: Enter the topology manually in the Reconstruction (Edit > Add area/line)
- or -
Change the local address for each of the "lines" e.g. for 1.1.3 to 1.1.x, for 1.2.5 to 1.2.x etc.
- or -
Correct the device addresses using ETS before using Reconstruction.

Battery-powered KNX RF devices

These activate their receivers only when needed and therefore cannot be found on line scan and
cannot be read without further action

What to do: Activate programming mode on the device

4.6 Why can a devic not be read out?

Possible causes:

You are using an older version of Reconstruction.

What to do: Please check in the ETS in the App Overview or in the KNX online shop whether
a newer version of Reconstruction is available and install it. Updates are free of charge.)

No product data found.

What to do: Import product data and perform "Read products". (=> What means "No
Productdata"?)

The Device is locked with a BCU password.

Usually, the device can still be read and reconstructed even if protected with a BCU
password. Depending on the actual product implementation, it might however not be possible
to later download a modified configuration into the device if the BCU password is not known.

What to do: As different products behave very differently regarding BCU password, please
consult product documentation or ask the device manufacturer if there is a way to reset the
BCU password. Ask the unit manufacturer if there is a way to delete the BCU password.
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The Device is protected with KNX data security.

There is no way to read out secured devices unless the tool key is known.

What to do: If there is a (perhaps older) version of the project, try to read the device with
reconstruction within this project. If the project contains the key of the device, this will
succeed. If there is a keyring backup, it can be loaded as described in KNX Data Security

The Device uses a PlugIn software (supplementary software).

Such devices can only be read out and reconstructed, if the device manufacturer supports
this (with an appropriate Reconstruction Plugin).

What to do: If the device uses a product-specific parameters dialog (see "parameters" in the
ETS) please take a look there for a product-specific reconstruction.
If the device is not already in ETS project, please mark it in the Reconstruction window and
perform "Reconstruct", so it will be inserted into the ets project. Alternatively, you can also
add it manually from The Product Catalog. Please insert the correct read out individual
address.
See also: Reconstruction and Plug-ins

The Application program is unloaded. To check, read the device via the ETS device info and
check the loaded state 

What to do: If the Application Program is unloaded the device memory may not contain
consistent data. 
Using the option "Identify Unloaded Devices" in Configuration you may also read devices with
unloaded Application Programs. However, the result is usually no meaningful data, which
cannot be reconstructed at all, only incompletely or even incorrectly.

ETS trys to use long frames. This will considerable speed up reading the devices if supported
by the device, the interface and any couplers in between.If these devices do not support long
frame, the device may not be able to be read.

What to do: disable "use long frames if supported" in  Configuration and try reading the
device once more. 

If the device still cannot be read out, please contact our Support, we will then try to find a solution.

See also: Data required for support

4.7 Which data can't be reconstructed?

Building and function structure

Names and descriptions of areas, lines, devices and group addresses

Some application programs contain parameters, which are not programmed into the device
(e.g. comments on the documentation). These functionally insignificant parameter values can
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therefore not be reconstructed.

4.8 Which data can be reconstructed?

Topology (areas and lines)
Devices

Individual address

Used application program

Parameter settings

Communication object flags and priority

Assigned group addresses

Group addresses

4.9 What does "No Productdata" mean?

 Reconstruction cannot find any product data in an ETS5/6 database or in the current ETS project which
matches for the read Application Program ID .
For reading and reconstruction product data will be needed with actually the same application program
(manufacturer, device type and version number)  as was used for programming the device. A former or
newer version of the application program won't help you.

Please perform "Read products" first to look for product data in ETS manufacturers' catalog as well as in
the Online Catalog (if selected in configuration). Then add them into the current ETS project. If you want
to get product data used in another project please open this project and perform "Read products" once
more.
If nevertheless no product data are found, please import the missing product data (=> Where do I find
suitable product data?) and perform "Read products" once more.

4.10 Where do I find suitable product data?

Import the current product databases of the listed manufacturers.
When all import ist done, please perform "Read products" in the current Reconstruction
project.

If that does not help: Ask the product manufacturer; with the help of the Application Program
ID. they may be able to provide you with the missing data.
For reading and reconstruction product data will be needed with actually the same Application
Program (manufacturer, device type and version number) as was used for programming the
device. A former or newer version of the application program won't help you. Product data
format (ETS2, ETS3 or ETS4/5 product data or even an ETS2, ETS3 or ETS4/5 project file) is
not relevant.

For couplers the Mask version is used instead of Application Program ID. Since no
manufacturer code is read out, product data for a coupler programme with the matching mask
version of any manufacturer is sufficient to read out the device.
For couplers often no application identifier can be read out. In this case the reconstruction
shows the mask version (e.g. 0912) instead. In this case it is best to look up directly in the
distribution which coupler product is installed, import the corresponding product data and
assign the product.

For some (only a few) products a re-import of product data is required. Please contact the
product manufacturer.
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Reconstruction can also work with product data that were inserted into ETS by project import -
even if they are not available in the ETS catalog. If there is any (older) ETS project file (prx, pr1,
.., pr5 and knxproj) with a device using the required product, please import it into ETS.
In ETS5/6: Please alos open this project and perform "Read products" in the current
reconstruction project.

For the customers of our Reconstruction there is a special tool ProductFinder available which
helps to get an overview of all Application Program IDs stored on your computer in product data
files (vdx, vd1, .., vd5 and knxprod) or ETS project files (prx, pr1, .., pr5 and knxproj). It provides
searching for a special Application Program in these files. 
ProductFinder is available at the IT GmbH.
Only for users of ProductFinder: starting with version 4.0.431 of reconstruction You may add a
product finder catalog file (xml) in the configuration settings of Reconstruction. 

Users of the IT GmbH online service select the appropriate option in the configuration settings
of the Reconstruction.

To view the search result, select the product entry in the list shown on Product page. A list of
product data or project files, containg the required Application Program (if found), will be shown
in the ETS sidebar. In ETS5, using the context menu, you can copy the file path and insert it
into the ETS import catalog dialog. In ETS6 however you can directly import it by clicking on
the link.

Attention!
When all import is done, please perform "Read products" in the current Reconstruction project. If product
data from another project should be used, please open this project before "Read products".

4.11 Why is the product data needed?

In Contrast to former versions of Reconstruction (e.g. 1.x and 2.x) the current version of Reconstruction
needs the complete product data for all types of devices before reading:

Devices with external processor can in general not be read completely without product
data, even if they report mask version $001x, because they normally contain additional
memory ranges.

Devices with ETS Plug-ins can in general only be read with the help of special
Reconstruction Plug-ins, because they possibly have different memory layout.

BCU2 and BIM M112 based devices can be read much faster with product data, because
the relevant memory ranges can be accessed selectively.

4.12 What does "Please select product" mean?

 Reconstruction cannot find a unique assignment between Application Program ID read from the device
and the product data in the ETS project. Possible reasons:

· product data contains only contains Application Program but no products. If you double-click on
the project or product page to open the list of available products, it is empty.
Please import product data and perform "Read Products".

· product data contains more than one product entry with different order numbers. 
Please double click in the column Product (project page or product page) and select one entry (=>
"Change product settings"). 
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In particular this applies for coupler devices which are not yet read. Here is only the mask version
known and the list of available products contains all coupler products from all manufacturers.

· product data in ETS project does not contain the combination of order number (stored in the
reconstruction file) and Application Program.
Please open the list of available products and select another one (=> "Change product settings")
or import new product data and perform "Read Products". 

4.13 Change product settings

There may be more than one product entry for an application program.
You can set the assignment either for several devices at once or for individual ones:
On the product page double click on an entry in the column Product. A list with all product entries
currently available in the ETS database for the appropriate application program appears. If necessary,
please correct the taken mappings after reading. This mapping applies to all devices with the previous
selected product.

If different devices with the same Application Program ID should use different product entries please
make changes on the project page for each device. Double-click on an entry in the Product column. A
list of all available entries for the corresponding application programs appears. This assignment is only
valid for the respective device.

Note: Application Program ID can not and must not be modified manually in Reconstruction.
Application Program ID is unique within all product data and identifies exactly the Application Program
used for programming the device. If changed reconstruction would try to access invalid device memory.

4.14 Product data for Couplers

Until now, no manufacturer or  application identifier has been stored in coupler units.

Reconstruction can therefore not determine from which manufacturer the device originates

You can use all coupler product data corresponding to the mask version read out for reading out the
coupler device.
The coupler mask versions Coupler 0900, Coupler 0910 and Coupler 0911 are compatible.

During Reading products Reconstruction searches for all matching coupler product data. You can then
select the matching coupler via the product selection dialog.
After reading devices, the product assignment for the coupler should no longer be changed. 

If you have accidentally assigned the wrong product to a coupler, you can still change the product
assignment afterwards. A corresponding entry is then written in the log text. 
In most cases, Reconstruction will work even if the product data for the coupler has been changed after
the readout.
If errors still occur, you should read out the coupler again with the correct product data:
Delete the device entry for the coupler in the project window of Reconstruction, scan the coupler device
again via the menu command Scan Single Device, then assign the correct product data and read coupler
device. 
Please ensure that the matching product data is available in the project (available in the local ETS
catalog and "Read products" has been executed). As a workaround, you have to manually import the
desired product data from the online catalog into the local ETS catalog.
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4.15 Info for device status

Depending on the progress of the read or reconstruction result for devices, there are different values for
device status:

Not identified The Device identification is not completed, e.g. Application Program ID
or mask version is missing.
That may happen in case of an error during scanning or when the device
was added manually but the address could not be found in the
installation.
It is also possible that the application program is not loaded. In this
case, the device memory most likely does not contain any consistent
data. However, you can still identify the device using the "Identify
unloaded devices" option in the configuration dialog.
Then please use "Scan single device" or scan complete line once more. 

Local Device is a local gateway. . It is neither identified nor read out or
reconstructed. 

No product data No product data was found for the Application Program ID read out.
Please perform "Read products" first. If no data was found, please import
the appropriate product data and run "Read products" again..

For reconstruction product data with the same Application Program ID
are required.  (=> What does "No Productdata" mean?)

Secure device cannot be
read

KNX Secure device can only be read out and reconstructed if it's keyring
file is available or anold project file is available (which was used while
programming the device) or Secure option was not used at all (when the
device was programmed).

Re-import product data Identifier from ETS product data.
After reconstruction process these devices are marked in ETS with a

yellow symbol , please also see ETS help on the device symbols. 
According to the ETS help, a yellow symbol in the ETS device window
means that, from a project point of view, the device information is
incomplete. 
The device can be edited and programmed, therefore it can be
completely reconstructed. 
(Exception: some products with ETS2 plug-ins, which cannot be inserted
into the ETS4/ETS5/ETS6 project because of using an ETS2 plug-in and
therefore cannot be reconstructed.) 
To add the possibly missing device information in the ETS, it helps to re-
import the product data and use the current product data. 
Unfortunately, this option does not usually help with the Reconstruction,
since exactly the version of the product data is required with which the
device was programmed.
For further questions, please contact the manufacturer of the device or
the KNX Association.

Unloaded The load status of the Application Program in the device is marked as
not loaded. The device memory may contain meaningless data which
cannot be reconstructed at all, or only incompletely or incorrectly.
Devices with unloaded Application Programs are therefore skipped during
identification. As described under "Not identified", unloaded devices can
also be identified, read out and reconstructed. 

Not read Device was not yet read 
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Read Device was read without errors

Read incomplete Device data read are incomplete, e.g. parameter image or group
communication tables are missing or incomplete (=> please try read
again)

As product data up to the version number exactly the same application
program is needed as read out. (=> Why does "No product data
available" appear?)

Not reconstructed Device was read, but not yet reconstructed or compared.
If this entry is marked with a red flag, further information may be available
as a tooltip or on the right-hand side of the property page under
Reconstruction Info. See also Device cannot be reconstructed.

Not supported  
Not reconstructable 
Not comparable

Current version of Reconstruction does not support reconstruction or
comparision of this device (different reason possible: plug-in or special
product format etc.)

Reconstruction OK Last reconstruction was successful, the ETS device's download image is
identical to the read image

Reconstruction incomplete Last reconstruction was not successful, e.g. the ETS device's download
image is different from the read image, or assigning group addresses
with group objects failed because of inactive group objects or mismatch
of length. You may increment the parameter settings' iterations steps,
as described in Incomplete reconstruction.

Identical Last compare did not find any differences, the ETS device's download
image is identical to the read image.

Differences found Last compare found differences

Not in ETS Project Device was not found in the ETS project. 

4.16 Incomplete reconstruction

Although most devices can be reconstructed easily and completely, there are individual exceptions.
Please see Reconstruction info on property page for details.

· Please check in the ETS in the app overview or in the KNX online shop whether a newer version of
Reconstruction is available and install it. Updates are free of charge.

· Devices with Plug-In software can use its own reconstruction methods. If the device uses a product-
specific parameters dialog (see "parameters" in ETS) please take a look there for a product-specific
reconstruction. See also Reconstruction and plug-ins.

· There are some application programs with complex parameter interdependencies that cannot be
resolved by Reconstruction in some combinations.

In these cases, the reconstruction mechanism performs an iteration through various combinations with
the aim of finding a parameter configuration which would produce the same download image as the
data read. Because the creation of the virtual device image is a very memory-intensive operation, the
Reconstruction stops after 100 iterations. If not all possible combinations have been tried, a
corresponding message is displayed in the Reconstruction info in the device's Properties dialog. 
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In these cases, it can be useful to increment the upper limit of 100 iteration attempts. Please expand
configuration settings just below the tool bar of  Reconstruction and increment the number of iterations
for undetermined parameters. Now re-start reconstruction only for the incomplete reconstructed device
by using the option selected. Note that reconstruction may take a long time.

· Another option for older multifunctional devices with a lot of virtual parameters: Disable the option "Use
algorithm for ETS4 applications also for older products" in the configuration settings. Now only
reconstruct the previously incompletely reconstructed device using the option "Marked", repeat this
procedure several times until all required parameters are determined

· Reconstruction will also fail when there are group addresses which cannot be linked with group
objects.

Maybe reconstructed parameters did not activate the mentioned group object. If there is a hint in
Reconstruction info that not all parameter combinations are tested, please increase the number of
iterations for undetermined parameters as described above. Alternatively, sometimes deactivating the
option "Use algorithm for ETS4 applications also for older products" with subsequent multiple
reconstructions can help.

Or maybe the group address is already connected to another group object with different length. In this
case of inconsistent data Reconstruction will fail until the invalid association is removed.

· In ETS5/6 group addresses without a connection can also get a datapoint type. If this datapoint type
does not match the connections the Reconstruction wants to create, please delete the group address
in the ETS first  Reconstruction will then insert it.

If the device is still not reconstructed completely, please contact our Support, we will then try to find a

solution.
See also: Data required for support

4.17 Reconstruction and plug-ins

Devices which use plug-ins normally can not be reconstructed without some additional information. So
Reconstruction provides an interface for a special reconstruction plug-in which can be implemented by
the product manufacturer and distributed by product data.

This special reconstruction plug-in will be automatically executed during device reconstruction and can
either implement its own reconstruction mechanism for parameter and group objects or handover this
task to standard mechanism of Reconstruction.
If a special reconstruction plug-in is used you will find a hint like "External association compare for
Plugin .." or "External association update for Plugin .." in the Reconstruction info.

For reading or reconstructing a device which uses plug-in ETS has to run in compatibility mode (In ETS5:
Apps overview in ETS, Compatibility Mode App from KNX Association has to be enabled. In ETS6:
Setting > Presentation >  Compitibility mode (check box) has to be enabled).
 
Plug-in devices without this reconstruction interface cannot be reconstructed by Reconstruction, but
some of them can be (partially) read at least. 

Some plug-in devices provide an own reconstruction option in the product-specific parameter dialog:
If the device is not yet part of the ETS project, please add it with the correct individual address, then
select "parameter" and open the product specific parameter dialog.
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4.18 Data required for support

To analyze a readout or reconstruction problem we need the following data:

· If product data are missing:

- the XML-file generated by the Reconstruction (in the reconstruction window "File > Save Current
State")  

- report "Missing Products" created from Reconstruction app

· If there is a problem with scan topology, scan or read devices: 

- ETS log file (can be packed into a zip file in ETS5/6 via Settings > Troubleshooting > Start Tool
Diagnostics)

- result of ETS Device Info with "Read group communication part" (in ETS5/6 in project Diagnostics
> Device Info)

- the XML-file generated by the Reconstruction (in Reconstruction window "File > Save Current
State")

- ETS project exported as knxproj file

· If there is a problem with reconstruction of devices:

- the XML-file generated by the Reconstruction (in Reconstruction window "File > Save Current
State") 

- ETS project exported as knxproj file

Please send the data together with an error description to: 
support@it-gmbh.de
If data require more than 50 MB storage space, please contact us.

4.19 Device cannot be reconstructed

· Please check in the ETS in the app overview or in the KNX online shop, whether a newer version of
Reconstruction is available and install it. Updates are free of charge.

· If the status of the device does not change after executing the Reconstruct command and no progress
bar with the reconstruction progress appears, please check whether a device with the specified
address already exists in the project and the option "Overwrite existing device" is set to "Never" in the
Reconstruct configuration. With this setting, existing devices are skipped during reconstruction.

· Devices with plugins cannot be reconstructed if the plugin manufacturer does not support the
reconstruction interface.
If the plugin supports reconstruction, ETS has to run in compatibility mode. See also: Reconstruction
and Plugins.

· Devices that are protected by Secure but for which no key is available (via a keyring file or an older
project state) cannot be read or reconstructed with the current version of %PRODUCTNAME%>.

· Inconsistent product data (rare): for a few devices, the product data is incorrect or does not match the
device in all cases. For example, according to the group communication tables read out, an

mailto:hotline@it-gmbh.de
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association is programmed via a group object with a certain length, but there is no matching group
object with this number and this length defined in the product data. 
These devices cannot be reconstructed. Please contact the device's manufacturer for further
information.
It is possible to completely reconstruct other devices with this product data, as long as no
associations are programmed via the non-matching group objects.

· If ETS is running in compatibility mode (Compatibility Mode App is selected in Apps overview in ETS5
or Compatibility mode is enabled in Settings in ETS6), memory problems may occur during an
extremely elaborate reconstruction process. You will then find an entry such as "An exception of the
type "System.OutOfMemoryException" was thrown" in the tooltip for the device status in the device
overview or in the properties dialog under Reconstruction Info. If you do not want to reconstruct a plug-
in device at the moment, please deactivate the compatibility mode of the ETS and restart the
Reconstruction. After the reconstruction, you can reactivate the Compatibility Mode. 

· Further information on why the reconstruction process is aborted or does not produce the desired
result can be found in the properties dialog under Reconstruction Info or as a tooltip in the status field
in the device overview and also here: Incomplete reconstruction 

4.20 What is the "Online-Service"?

IT GmbH provides from version 5.0.1516 a (chargeable) online service that gives you access to
thousands of current and older product data. Data from over 15,000 application programs is currently
available there.

Products that do not yet exist in the project are automatically searched for via the online service and can
be downloaded directly from within the Reconstruction app (ETS5) or even imported directly (ETS6).

To access, you need a personalized key, which you can purchase from sales@it-gmbh.de. Enter this
key in the Configuration Dialog.

We put a lot of effort into the maintenance of this database and therefore ask for your understanding that
the personalized key is only intended for the acquirer and may not be passed on to third parties!

4.21 How is the Product finder catalog file generated?

Product finder catalog file is generated by using the ProductFinder tool.

mailto:sales@it-gmbh.de
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5 Imprint

The information and data contained in this document are subject to change without prior notice. The
names and data used in examples are fictitious if not noted otherwise. You may not reproduce or copy
this document, or any portion thereof, for any purpose without the explicit written consent of IT GmbH,
regardless of the mode and means, electronically or mechanically.

© 1995 - 2023 IT Gesellschaft für Informationstechnik mbH

IT Gesellschaft für Informationstechnik mbH
An der Kaufleite 12
D-90562 Kalchreuth
Germany

All rights reserved.

Issued: April 2023

Windows is a trademark of the Microsoft Corporation.

ETS is a registered trademark of KNX Association c.v.b.a.
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6 Contact

Orders
ETS App Reconstruction is available only at KNX Onlineshop.
For information and orders please contact our sales office:

Phone: +49 (0) 911 518349-0 (Mo-Fr 9 a.m. to 4 p.m.)
Email: vertrieb@it-gmbh.de

Support Service
If you have questions or problems, you may contact our support:

Phone: +49 (0) 911 518349-10 (Mo-Fr 9 a.m. to 4 p.m.)
Email: support@it-gmbh.de
WEB: problem report

Newsletter
We would like to inform you about useful additional products and news. If you wish, please register for
our newsletter. Click on the link below to access our newsletter registration page. You can cancel your
registration at any time without giving any reasons.

Subscribe to the newsletter

IT GmbH 
An der Kaufleite 12 
D-90562 Kalchreuth
https://www.it-gmbh.de
Germany

mailto:vertrieb@it-gmbh.de
mailto:hotline@it-gmbh.de
https://www.it-gmbh.de/en/support/service/feedback.html
https://www.it-gmbh.de/en/newsletter.html
https://www.it-gmbh.de
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7 Feedback

Please help us to improve Reconstruction. Your feedback may influence further development so that in
subsequent Reconstruction versions and manual editions your wishes and requirements may be taken
into consideration. We look forward to receiving your comments and wishes on the content,
representation of associations as well as comprehensibility regarding Reconstruction program parts or
documentation. Please also let us know if you have any improvement suggestions with regard to support,
training or sales. 

Feedback via IT Website

https://www.it-gmbh.de/en/support/service/feedback.html
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